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Predgovor

Danasnje drustvo obiljeZeno je naglim rastom i razvojem informacijske tehnologije (IT), Sto
je rezultiralo velikom ovisno$¢u drustva, u Sirem smislu, o znanju i kompetencijama osobe
u IT podrudju. | premda ta ovisnost raste iz dana u dan, ljudsko pravo na obrazovanje i
informacije nije prosireno i na IT podrucje. Pojavili su se problemi koji utje¢u na drustvo u
cjelini, koji stvaraju prepreke i udaljavaju ljude od glavnog razloga i motivacije za napredak,
od prilike. Danas, biti racunalno nepismena osoba, znaci biti osoba koja nije u moguénosti
sudjelovati u modernom drustvu, osoba bez prilike, i unato¢ priznatoj neophodnosti i
korisnosti inkluzivne informaticke pismenosti, od strane Europske komisije, UNESCO-a,
OECD-ai ostalih relevantnih institucija, jos uvijek postoje grupe ljudi sa otezanim pristupom
osnovnoj racunalnoj naobrazbi (npr. osobe s invaliditetom, osobe s poteskoéama u uceniju,
radnice/i migranti, nezaposlene osobe, osobe koje Zive na udaljenim mjestima gdje nemaju

pristup racunalnoj edukaciji).

Ova skripta, zajedno sa ostalim materijalom objavljenim na stranici ITdesk.info, predstavljaju
nas doprinos realizaciji i promociji ljudskog prava na edukaciju i informacije u IT podrucju.
Nadamo se da ée Vam ova edukacija pomoci u savladavanju osnovnih racunalnih vjestina i
s tom nadom Zelimo Vam da naucite $to vise i tako postanete aktivni/a ¢lan/ica modernog

IT drustva.

Iskreno Vasi,

ITdesk.info team

desk.
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Microsoft Word 2010 Beta — elementi sucelja
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1. Gumbi za manipulaciju prozorom — minimiziranje, maksimiziranje, zatvaranje prozora

2. Naslovna traka —ime dokumenta, ekstenzija ili nastavak (.docx) te ime programa

3. Kartice / tabs

o Datoteka / File
o Pocetna/Home

o Umetni/ Insert

o lzgled stranice / Page Layout

4. Trake s alatima / Toolbars

o Reference / References
o Posta / Mailings
o Prikaz / Review

o Pogled / View

o neke skrivene naredbe imaju strelicu pokraj te naredbe za otvaranje dodatnih opcija

o zasivljene naredbe su one koje se ne mogu trenutno izvrsiti (na slici: Change List Level)

o naredbe s tri tocke imaju slijed daljnjih naredbi (na slici: Define New Bullet...)

e kartice i alatne trake zajedno se nazivaju vrpca (ribbon)

@ (FIE(E) ITdesk.info is licensed under a Creative Commons Attribution-
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5. Radna povrsina — papir, ovdje upisujemo tekst, ubacujemo objekt
6. Tocka umetanja, mjesto gdje treperi kursor
7. Trake za horizontalnu i vertikalnu navigaciju (klizaci)
o dvostruka strelica gore/dolje prebacuje pogled za jednu stranicu vise/manje
8. Statusna traka

o prikazuje podatke o trenutnom poloZaju to¢ke umetanja na radnoj povrsini i stanje
nekih posebnih funkcija Microsoft Word-a

9. Ravnala - horizontalno i vertikalno ravnalo, iznad i s lijeve strane sucelja

o bijelo podrucje oznacava prostor za pisanje, sivo podrucje predstavlja margine

Oznacavanje teksta

Prije uredivanja teksta potrebno je oznaciti dio teksta nad kojim ¢e se izvrsiti odredeno oblikovanje.

Oznacavanje proizvoljnog teksta:

e pritisnemo i zadrZimo lijevu tipku misa, prijedemo miSem od pocetka do kraja teksta koji
Zelimo oznaciti te otpustimo lijevu tipku

e postavljanjem tocke umetanja na mjesto pocetka oznacavanja, pritiskom na tipku Shift te
pritiskom lijeve tipke miSa na mjesto Zeljenog zavrSetka oznacavanja

Oznacavanje jedne rijeci: dvostruki pritisak lijeve tipke misa na rijec.
Oznacavanje jedne recenice: pritisnemo tipku Ctrl i pritisak lijeve tipke misa bilo gdje u Zeljenoj recenici.

Oznacavanje jednog retka: u prostoru margine lijevo od retka pritisnemo lijevu tipku misa (pokazivac
mora biti u obliku bijele strelice).

Oznacavanje vise redaka: u prostoru margine lijevo od redaka, pritisnemo i zadrzimo lijevu tipku misa te
se pomicemo gore ili dolje preko redaka koje Zelimo oznaciti te otpustimo tipku misa.

Oznacavanje nesusjednih redaka: u prostoru lijeve margine pritisnemo tipku Ctrl + pritisnemo lijevu tipku
misa na Zeljene retke.

Oznacavanje jednog odlomka: u prostoru margine lijevo od odlomka, dvostruki pritisak lijeve tipke, ili
trostruki pritisak lijeve tipke misa unutar odlomka.

Oznacavanje cijelog dokumenta: trostruki pritisak lijeve tipke misa u prostoru lijeve margine, ili precica na
tipkovnici Ctrl + A.
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Umnozavanje teksta unutar dokumenta
i izmedu otvorenih dokumenata

e Kopiraj / zalijepi (Copy / Paste):
1. oznacimo tekst koji Zelimo kopirati
2. kopiramo oznaceni dio teksta pomocu alata Kopiraj (Copy) ﬂ (Ctrl +C)

3. postavimo tocku umetanja na mjesto gdje Zelimo smjestiti tekst
4. zalijepimo tekst na to mjesto pomocu alata Zalijepi (Paste) g (Ctrl + V)

e Kopiranje pomocu metode uhvati — vuci — pusti (drag and drop)
1. oznacimo tekst koji Zelimo kopirati

2. naoznacenom tekstu pritisnemo i zadrzimo lijevu tipku misa te pritisnemo i zadrzimo
tipku Ctrl.

3. vucemo pokaziva¢ misa

4. otpustimo tipku misa i potom tipku Ctrl. Tekst je zalijepljen na novu poziciju.

e Izrezi / zalijepi (Cut / Paste):

1. oznacimo tekst koji zelimo premjestiti

2. izrezemo oznaceni dio teksta pomocu alata IzreZi (Cut) . (Ctrl +X)

3. postavimo tocku umetanja na mjesto gdje Zelimo smjestiti tekst
4. zalijepimo tekst na to mjesto pomocu alata Zalijepi (Paste) .& (Ctrl + V)

e PremjeStanje pomocu metode uhvati — vuci — pusti (drag and drop): kao i kopiranje, ali bez
tipke Ctrl

Brisanje teksta

o slovo po slovo: tipka Delete briSe znak desno od kursora, a tipka BackSpace briSe znak
lijevo od kursora

o brzi nacin brisanja - oznacimo Zeljeni dio teksta i pritisnemo tipku Delete

ﬂ E E ITdesk.info is licensed under a Creative Commons Attribution-
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Ponistavanje izmjena (Undo) i ponistavanje
ponisStavanja izmjena (Redo)

Ponisti (Undo) .ﬂ.: | Ponovi (Redo) -E-T-

Pritiskom na strelicu pokraj alata otvara se padajudi izbornik sa popisom svih akcija koje smo napravili.

Uvijek prvo oznac¢imo tekst pa odaberemo Zeljeni alat,strelica prema dolje pokraj alata daje dodatne
opcije

lzbornik: Datoteka / File

Stvaranje novog dokumenta: New > Blank document > Create (precica na tipkovnici Ctrl + N)

™ R Rt RE Documentl - Microseft Werd

“ Home [nzert Page Layaut References Klailings Reviewr View

H Save
Available Templates Blank decument
E Save A5
&5 Open b+ fi} Home
I:]" Clase I =, 5 12 -
R =
mfo L;, | |
b = - "
Fecent Recent Sample My templates  Mew from
templakes templetes existing
“ Office.com Templates |E-::r-:* Office.com fortemplates | +

Print ﬁ— = = —

i P o wl : , Lu _ =l

Share __ F :_-} LFrEEE | 2 \ 5 T

Hel Budgets Business Calzndars Fenies Forms Gift:

¢ cards certificates
4 Options —[% = [ = —
== == — :
Exit = ! N
@ 1) =5 3 (=2 l =
Invoices Minutes Plannzis Plans Muore j
:utegnrie:-

Create

Otvaranje postojeceg dokumenta - alatom Otvori / Open ﬁ' (precica na tipkovnici Ctrl + O)

Otvaranje viSe od jednog dokumenta: uz pomoc tipke Ctrl ili Shift

ﬂ E E ITdesk.info is licensed under a Creative Commons Attribution-
Noncommercial-No Derivative Works 3.0 Croatia License

EY MC HD




ITdesk.info — projekt racunalne e-edukacije sa slobodnim pristupom

Alat Spremi (Save) R (precica na tipkovnici Ctrl + S)

e Spremiu / Save in - u koju mapu ¢e se dokument spremiti
e Ime datoteke / File name - upiSemo naziv datoteke

e Spremi kao tip / Save as type — program u kojem spremamo dokument (MS Word .docx)

Olaksano je kreiranje novog dokumenta koristenjem predloska — ekstenzija (nastavak) .docx

Options > kartica Save > Save AutoRecover info every (odrediti)

Ispis / Print:

e  Printer — odabiremo pisac

e Page range: All —sve Current page — trenutna stranica Pages — samostalan
odabir stranica

e Copies — broj kopija dokumenta

e (Collated —ispisuje se cijeli dokument od pocetka do kraja, a zatim prema zadanom broju ko-
pija, Uncollated — ispisuje se prva stranica prema zadanom broju kopija, zatim druga itd.

e Margins — od nekoliko ponudenih veli¢ina margina odaberemo jednu
e QOrijentacija / Orientation:
o Portrait (vertikalan papir)

o Landscape (horizontalan papir)

KARTICA: PoCetna / Home

E“ H9-0|- Documentl - Microsoft Word o B

W Insert Page Layout References Mailings Review View &

el .
1 & i - - A - Heg g & Find -
- CaibriBodyl - 11~ A A7 Aav  ®) =i EE 2L T pagncene| asBbocde AaBbCi AaBbCe 2 Replac
=] - hae 4
Paste - 2 )\ v - - === ‘t=- - e i i i Change
N y B 7 U ~abe x, x| [\~ é = =EE = é B TMNormal | T No Spaci.. Headingl Heading2 _ Stylesgv [y Select®
Clipboard = | Font ] | Paragraph ] | Styles [F} | Editing

Vrsta slova (font): Times New Roman, Verdana, Ariel, Calibri (na slici) itd.

Veli¢ina slova / Font Size — padajudi izbornik 112—-:-:

Oblikovanje teksta: B 7 U]

Podebljanje (Bold) Zakosenje (Italic) Podvlacenje (Underline)

-Ctrl+B - Ctrl +1 - Ctrl + U - tipkovna precica
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Primjena efekata (precrtavanje, indeksiranje, eksponiranje)

e Precrtani tekst (Strikethrough) nrekakav-tekst
e Indeks (Subscript) H20 > H20
e Eksponent (Superscript) 5m2>5m?

Kliknemo na sivu strelicu pokraj ,,Font” il- (ili precica na tipkovnici Ctrl + D), a ostali efekti koji se mogu
primijeniti su: Dvostruko precrtano (Double Strikethrough), Sjena (Shadow), Kontura (Outline), Reljefno
(Emboss), Ugravirano (Engrave), Smanjena velika slova (Small caps), Sve velika slova (All caps), Skriveno
Skriveni tekst je skriven pri ispisu (Hidden).

Mala slova pretvoriti u velika ili obrnuto: Aam VELIKA SLOVA / UPPERCASE
- mala slova / lowercase
Text Effects A~ - sadrzi opcije oblikovanja teksta: Sjena / Shadow, Odsjaj / Reflection
. W - o .
Text Highlight Color - alat za isticanje teksta bojom

-

Sjencanje / Shading & - alat za bojanje pozadine teksta

-

Obrubi / Borders = - alat za postavljanje raznih vrsta linija oko oznacenog teksta

A b
Bojanje teksta razli¢itim bojama: alat Font Color ==

Graficke i numericke liste:

i —
i —

1 =
Grafi¢ke liste / Bullets 5= Numericke liste / Numbering h

e umetanje nove oznacene stavke — Enter na tipkovnici, prestanak oznac¢avanja — dva puta En-
ter

Poravnanje teksta @

Poravnaj: lijevo / Align Left, po sredini / Centar, desno / Align Right, obostrano / Justify

Odabir proreda unutar odlomka

=,
- alat Line Spacing ‘=
Prikazivanje i sakrivanje znakova koji nisu za ispis

- Alat Show / Hide ..1[...
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Stilovi:
e primjena stila — nakon oznacavanja teksta, kliknemo na ponudeni stil / style

o lli pritisnemo " kod izbornika stilova > odaberemo stil > Primjeni stil / Apply Style

e izmjena stila - pritisnemo > Primjeni stil > Izmjeni (Apply Style > Modify)

e izrada novog stila: ozna¢imo tekst sa Zeljenim oblikovanjem, pritisnemo ~ kod izbornika
stilova > Spremi oznaceno kao novi stil / Save Selection as a New Quick Style

TraZenje odredene rijeci ili fraze

e Nadi/ Find, upisemo frazu, Pronadi slijedece / Find Next

Ve o

zamjena odredene rijeci ili fraze
e Find What — koju rijec trazimo
e Replace With - ¢ime Zelimo zamijeniti
Prenosenje oblikovanja s jednog dijela teksta na drugi

- alat Format Painter -ﬁn

Pomo¢ u MS Wordu - alat Help @ , F1 na tipkovnici

KARTICA: Umetanje / Insert

Wid9-o|- Documentl - Microsoft Word = =
.ﬂu Home Insert Page Layout References Mailings Review View &
Cover Page = E ElE ’{—j) a 1 & Hyperlink |5 Header - |Z| Quick Parts = [ Signature Line ~  JT Equation
| -+ —

|_] Elank Page EE] = Oy A Bookmark |_§ Footer ~ dWordAr‘t' @Date & Time €2 Symbol =
= Table | Picture Clip Shapes SmartArt Chart Screenshot Te: Az

¥= Page Break - Art - B [ Cross-reference | [#] Page Number | ggy- 2= Drop Cap Fgd Object ~

Pages | Tables | Illustrations | Links | Header & Footer | Text | Symbols

Prijelom stranice

1=l
/ Page Break "= Fa0e Break

e uklanjanje prijeloma: uklju¢imo Show / Hide, odaberemo oznaku Page Break, tipka Delete
=] Header ~

Zaglavlje i podnoZje (Header and Footer) = ™o~

e uredivanje: dvostrukim klikom u prostor zaglavlja ili podnoZzja ili: pritisak na desnu tipku misa
i odabir naredbe Uredi / Edit

e izlazimo iz polja zaglavlja/podnoZja: dvostruki klik na radnu povrsinu aplikacije
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Umetanje polja (Quick Parts > Field...) @ QuiFart: -

e mozemo umetnuti: broj stranice, datum, vrijeme, autora/icu dokumenta itd.

Automatsko numeriranje stranica = "¢ tumber

e Vrh stranice / Top of page
e Dno stranice / Bottom of page

e te lijevi ili desni kut ili sredina stranice

iz

Tablice ™"

e umetanje tablice: miSem prelazimo preko kockica ¢ime odredujemo broj stupaca i redaka
o ili odaberemo opciju Umetni tablicu / Insert Table i upisemo brojeve
e promjena polozaja tocke umetanja: tipka Tab, tipke sa strelicama na tipkovnici, pritiskom
lijeve tipke misa u Zeljenu celiju
e uredivanje tablice: Table Tools > Obrubi / Borders

> Sjencanje / Shading
e naknadno umetanje retka ili stupca:

o tocku umetanja smjestimo u celiju gdje Zelimo umetnuti redak ili stupac, pritisnemo
desnu tipku misa te na brzom izborniku odaberemo Umetni > red iznad (Insert > Row
Above) ili ispod (Below)

o ili Umetni > stupac lijevo (Insert > Column Left) ili desno (Right)

e Drisanje retka ili stupca

o oznacimo redak ili stupac, pozovemo brzi izbornik te izaberemo opciju Obrisi stupce
(Delete Columns) ili Obrisi retke (Delete Rows)

o brisanje tablice: oznadimo tablicu i pritisnemo tipku Delete

Slike Picture
e oznacavanje slike radimo pritiskom lijeve tipke miSa na Zeljeni objekt, nakon ¢ega objekt na
obrubu dobije kvadratic¢e

e za pomicanje slike na proizvoljno mjesto: oznacimo sliku, desna tipka misa > Format Picture >
Layout > Wrap, odaberemo stil

e podesavanje veli¢ine objekta
o rucno: ozna¢imo objekt, pomi¢emo neke od rubnih tocaka na okviru objekta

o upisom vrijednosti: desni klik na objekt > Format Picture > kartica Size > unijeti vrijed-
nosti za visinu (Height) i Sirinu (Width)

£2 symbal -

Umetanje simbola €f OcQ+Hay ® s = 2 @ itd.

ﬂ E E ITdesk.info is licensed under a Creative Commons Attribution-
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KARTICA: Izgled stranice / Page Layout

| H9-0l- Documentl - Microsoft Word o &
Home Insert Page Layout References Mailings Review View &
@ 3 Orientation = ¥= Breaks ~ |A watermark = Indent Spacing J j [ Bring Forward |= Align ~
I|_j Size = %I:‘] Line Mumbers = @ Page Color = ‘EE Left:  0ecm - :Z Before: 0 pt - &k send Backward E Group
Themes Marglns _ X . " = — | Position W rap
- @' £E Columns = b~ Hyphenation @ Page Borders | £% Right: 0cm - :E After: 10 pt - %Selectlon Pane Sl Rotate
Themes | Page Setup P ‘ Page Background | Paragraph P | Arrange
e Margine / Margins: odaberemo ponudene margine s obzirom na Zeljenu visinu, Sirinu
e Orijentacija / Orientation: Portrait — okomito postavljen papir, Landscape — vodoravno post-
avljen papir, za tablice
e \Veli¢ina / Size - podesavanje dimenzija papira
e Automatska funkcija za rastavljanje rijeci / Hyphenation
o None (nikakva), Automatic, Manual
e Obrub stranice / Page borders — razlicite vrste i debljine linija mogu biti obrub i cijeloj stranici
e Uvlaka / Indent - uvuéenost retka
KARTICA: Posta / Mailings
M= - s Doumentl - Miorosoft Ward

File Home Ins=rt Pages Layout References Kailings | Revisw Wisw

- I_E "=Ij i J J j 2 Rules {_\i?j H +4 F M =
=l i - <1 Maten Flelds 4 | #Fnd Reapient M
Envelopes Labels  |StartMall| Select Edit Highlight  Address Greeting Insert Merge Previews | o : Finish &
Merge - |Recipicnts = Resipient List | Merge Fields  Blaoos Line Firld 3| Update Labsls | pecjs = Auta Check for Errors Mergs
Create L-i'l Letters Wifrike & [nsert Fields Freview Resulis Finish
(= E-mall Messages i
=1 Enuelopes...
il Labels.
E Directary
[W] romalword Dooument
&) Step by Step Mail Merge Wizard..,

Skupno pismo, pismo s istim sadrzajem koje Saljemo na viSe adresa

e Kreiranje: Start Mail Merge > Step by Step Mail Merge Wizard (kao na slici iznad)

1) Odabir vrste dokumenta na kojem Zelimo kreirati skupno pismo

e Pismo — tekst koji se razlikuje samo po umetnutim poljima
*  Poruka e-poste — kao i kod pisma

*  Omotnice —ispis imena i adrese primatelja

* Naljepnice

* Imenik — cijeli dokument predstavlja ispis po poljima podataka iz baze podataka

ﬂ E E ITdesk.info is licensed under a Creative Commons Attribution-
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2) Odabir polaznog dokumenta

e Upotrijebi teku¢i dokument — dokument koji upravo koristimo
e Pocni od predloska — odaberemo predloZak

*  Postojeci dokument — navigiramo do i otvorimo postoje¢i dokument
3) Odabir primatelja

»  Koristi postojeci popis — koristimo imena i adrese iz datoteke ili baze podataka
* |zaberi medu kontaktima u Outlook-u / Select from Outlook contacts
»  Utipkaj novi popis > kreiraj / Type a new list > Create
4) Organizacija svoje datoteke / Arrange your directory — dodajemo informacije o primatelju;

odredimo mjesto u dokumentu te kliknimo na jednu od stavki: Adresni blok, Pozdravi
itd.

5) Pregled svoje datoteke / Preview your directory — takoder mozemo urediti popis
primatelja

6) Zavrsavanje skupnog pisma / Complete the merge

KARTICA: Prikaz / Review

WiH9-0l- Documentl - Microsoft Word o &
Home Insert Page Layout References Mailings Review View &

g [, Research a‘tﬁ ﬁ \j & Delete 9 o 2% Final: Show Markup - @ @ 3 Previous j SE %

- i, . A =
% Thesaurus 3 Previous * 3 show Markup - P} Next
Spelling & g Translate Language Mew N Track Accept Reject Compare Block  Restrict
Grammar jzg \Word Count - - Comment . Mext Changes ~ [B] Reviewing Pane - - - - Authors = Editing
Proofing | Language | Comments | Tracking | Changes | Compare ‘ Protect

e rijeci koje su krivo upisane bit ¢e podvucene crvenim, valovitim linijama

e podesenja: Review > Language > Set Proofing Language

e Alat Spelling and Grammar .z - otvara se dijaloski okvir sa opcijama: ignororaj jednom,
ignoriraj sve, promjeni, promjeni sve (Ignore once, Ignore all, Change, Change all)

o ako se neka rije¢ ne nalazi u rje¢niku tada ju moZemo unijeti u rjecnik oznacivsi je > pritisak
desne tipke misa nad oznacenom rijeci > Add to dictionary

ﬂ E E ITdesk.info is licensed under a Creative Commons Attribution-
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KARTICA: Pogled / View

M E9- U= Documentl - Microsoft Word =

M Insert Page Layout References Mailings Review View

- E . . [ ruter Q ‘ ‘JOI"IE Page @ E . [ View Side by Side %@
. Gridlines Bl @Two Pages _1: Synchronous Scrolling %
Print [Full Screen Web  OQutline Draft Zoom 100% Mew  Arrange Split
Layout | Reading Layout [ Mavigation Pane =] Page Width Window Al #4 Reset Window Position ' windows ~ -

Switch Macros

Document Views | Show | Zoom | ‘Window | Macros |

e slijededi alati se nalaze u kartici Pogled/View i u donjem desnom kutu aplikacije (na Status-
noj traci):

o Print Layout - kako ce se na ispisnoj stranici raspodijeliti tekst i razliciti objekti, najéesée
koristeni pogled

o Full Screen Reading - pogodan za Citanje dokumenta
o Web Layout - pogled se koristi za izradu web stranice

o Outline — pogled na strukturu dokumenta, olaksan rad sa premjestanjem, kopiranjem,
uredivanjem teksta te promjenom razine naslova

o Draft — pogled na dokument kao na nacrt, odredeni elementi (kao npr. zaglavlje) se ne
vide

o Zoom — odabir ponudene ili unos vrijednosti

Page Width - prikaz po Sirini stranice Whole Page — prikaz Citave stranice

Text Width - prikaz po Sirini teksta Two Pages — prikaz dviju stranica

Upotreba tabulatora

e pritiskom na tipku TAB na tipkovnici, tocka umetanja se pomakne za 1,25 cm udesno
e upotrebom tabulatora, moZemo tocno definirati gdje Zelimo da se pomakne tocka umetanja

e tabulatori:

IE' - lijevi tabulator II' - desni tabulator

- tabulator centriranja ! - decimalni tabulator

ravnalo / Ruler treba biti vidljivo Ruler

e ikona tabulatora s lijeve strane ravnala omogucuje nam odabir vrste tabulatora
e na Zeljenu poziciju na ravnalu pritisnemo lijevu tipku misa

e tipkom TAB prelazimo od jednog do drugog tabulatora

e uklanjanje tabulatora: pritisnemo i zadrzimo lijevu tipku misa na njemu te povuc¢emo prema
dolje i potom otpustimo tipku misa

ﬂ E E ITdesk.info is licensed under a Creative Commons Attribution-
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Ova skripta je namijenjena za ucenje uz materijale
objavljene na slijedec¢im linkovima:

* Prirucnik:

http://www.itdesk.info/prirucnik obrada teksta microsoft word 2010.pdf

* Video prezentacije koje prikazuju rad u Microsoft Word 2010:
e  http://www.itdesk.info/hrvatski/microsoft-word-1/

e http://www.itdesk.info/hrvatski/microsoft-word-2/

e http://www.itdesk.info/hrvatski/microsoft-word-3/

e http://www.itdesk.info/hrvatski/microsoft-word-4/

* Probni ispit:

http://www.itdesk.info/primjeri ispita/primjer ispita modul 3.pdf

* Video-prezentacija koja prikazuje rieSavanje primjera ispita:

http://www.itdesk.info/hrvatski/obrada-teksta-microsoft-word-2010-video-rjesenje-ispita/

* Kvizevi koji korisnici/ce sami rjesavaju:
e http://www.itdesk.info/hrvatski/obrada-teksta-kviz-1/
e http://www.itdesk.info/hrvatski/obrada-teksta-kviz-2/
e http://www.itdesk.info/hrvatski/obrada-teksta-kviz-3/

(za otvaranje linka koji se nalazi unutar .pdf dokumenta samo pritisnite lijevu tipku misa na jedan
od navedenih linkova. Web stranica na koju link pokazuje ée se otvoriti u Internet pregledniku koji

imate instaliran na racunalu.)

ITdesk.info is licensed under a Creative Commons Attribution-
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Opdi uvjeti koristenja

Web stranicu www.ITdesk.info je pokrenula udruga “Otvoreno drustvo za razmjenu ideja -
ODRAZI” u sklopu aktivhog promoviranja ljudskog prava na slobodan pristup informacijama te
ljudskog prava na edukaciju.

Slobodno kopirajte i distribuirajte ovaj dokument, uz uvjet da ne mijenjate nista u njemu!

Nad svim programima i uslugama navedenim na web stranici ITdesk Home na web adresi ITdesk.info
isklju¢ivo pravo posjeduju njihovi autori/ce. Microsoft, Windows, i Windowsxx su registrirani zastitni
znakovi tvrtke Microsoft Corporation. Ostali zastitni znaci koriSteni na ITdesk Home Web stranicama su
iskljucivo vlasnistvo njihovih vlasnika/ca. Ukoliko imate pitanja vezana uz uporabu ili redistribuciju bilo
kojeg programa, molimo kontaktirajte autore/ice doticnog programa. Sva dodatna pitanja posaljite na
info@itdesk.info.

Ove web stranice sadrzavaju linkove na ostale web stranice ili izvore. ITdesk.info team NIJE odgovoran za
tekstualni i/ili reklamni sadrZaj, odnosno za proizvode koji su na tim web stranicama/izvorima ponudeni,
kao Sto NIJE odgovoran niti za sadrzaj koji je putem njih dostupan; mogucnost koristenja ili to¢nost
sadrzaja. Linkove koristite na vlastitu odgovornost. Takoder, ITdesk.info team ne garantira:

e daje sadriaj na ovim web stranicama osloboden od pogresaka ili pogodan za svaku svrhu,

e da ¢e ove web stranice ili web usluge funkcionirati bez pogresaka ili prekida,

da ce biti odgovarajuci za vase potrebe,

da implementacija takvog sadrZaja nece narusavati patente, autorska prava, zastitni znak ili
ostala prava neke trece strane.

Ukoliko se ne slaZete s ovim opéim uvjetima koristenja ili ako niste zadovoljni web stranicama koje pruzamo,
prekinite s koriStenjem ovih web stranica i web usluga. ITdesk.info team nije odgovoran vama, niti tre¢im
osobama za bilo koju nastalu Stetu, bila ona direktna, indirektna, slucajna ili posljedi¢na, povezana s
vasom uporabom ili proizlazila iz vaSe uporabe, pogresne uporabe ovih web stranica ili web usluga. lako
vase potraZivanje mozZe biti bazirano na garanciji, ugovoru, prekrsaju ili nekom drugom pravnom uporistu,
neovisno o nasoj obavijestenosti o moguénosti nastanka takve Stete, oslobadamo se svake odgovornosti.
Prihvadanje ograni¢enja nase odgovornosti nuzan je preduvjet koriStenja ovih web stranica i web usluga.

Svi softveri navedeni u ovomili drugim dokumentima objavljenim na stranici ITdesk.info su navedeni samo
za edukativne svrhe ili kao primjer te mi, na bilo koji nacin, ne preferiramo navedeni softver u odnosu na
neki drugi softver. Bilo koju izjavu da neki navedeni softver preferiramo vise u odnosu na drugi, koji se
spominje ili ne spominje u materijalima, smatrat ¢e se kao laZzni iskaz. Nasu izravnu i bezrezervnu podrsku
imaju jedino softveri otvorenog koda (open source) koji omogucuju korisnicima/cama da bez prepreka
postanu digitalno pismeni, koriste ra¢unalo i sudjeluju u modernom informati¢ckom drustvu.
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